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Reinvent business operations to be customer-centric with Smarter Process
Don Seymour (BPM Sales Leader, IBM Central & Eastern Europe)

Vallalati mobil platform esettanulmanyok

Toth Balint (IBM), Banki Zsolt (UniOffice)

Mire j0 a 'data grid‘?
Klis Csaba (IBM)

SOA a gyakorlatban
Gulyas Gergely (IBM)
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Smarter Process - A briefing for WebSphere Klub

Don Seymour
Smarter Process Sales Leader — Central & Eastern Europe

don.seymour@cz.ibm.com
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BPM — a look back
The need - reinventing business operations

Operational results - from Smarter Processes

© 2014 I1BM Corporation



IBM Software

A brief history of process management

2007
2012

Continuous
Process
Improvement

What is the goal?

Source: Gartner
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Managing complexity is a challenge in every industry

COMPLEXITY MANAGEMENT VS. PRODUCTIVE TIME

-+— 100%

Time Managing Internal
Process Complexity

Productive Time
Dealing with Customers

Airline Manufacturing  Automotive Industrial Telecom Retail Health
Maintenance Bank Payor

Complexity threatens to reduce customer engagement

Source: Booz and Co., 2013
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Market

Shifts

In the digital economy

Shift in personalized computing
to mobile using cloud services

Shift towards unbundled
business offerings

Shift towards killer-apps
transforming industries

© 2014 I1BM Corporation
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Smarter Process is IBM’s approach for reinventing business
operations in order to help you achieve customer centricity

A Smarter Process.--

7 Mobile

Empower business users Accolerato A
to collaborate and act on

> S o Cia I Speerved insights J L_ |

. — process

I
> Cloud ‘“—*: ;

H | Engage anywhere; Customize, | Enable f: b jecisions in
I D a t capture & digitize mobile-specific response to business situations
s A ate develop " -— and opportunities

...is a Data-Driven Process
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Customer-centric reinvention is paramount

Processes Must Now Be
A.

Instant_

At Internet speed

of leaders expect consumers to
gain even more power and
influence of their businesses

Broadcast Music Inc (BMI) shortens artist
onboarding time by 93%, processing 100B+
transactions

58%

Seamless

Interconnected & ubiquitous

of business executives expect new
technology to reduce barriers to
entry

Visa Europe handles cross border
payments across 36 currency markets

69%
Insightful

Targeted and relevant

Hospitals Contribution Fund (HCF) provides
preventative heathcare options and grows its
market share by 56%

of business leaders expect more
cross-industry competition

~ Digital Reinvention: Preparing for a very different
tomorrow. IBM Institute of Business Value, 2013

© 2014 I1BM Corporation
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Customer centricity supports a spectrum of work types

Automated straight-
thru processing

Procedural, task-
based work

Dynamic, goal-

driven work; case

Business “Programmers”

h

= Creates process models
and workflow diagrams
= Defines business rules

operations

and events to drive
behavior

= Utilizes analytics to gain
insights in how to improve

7

Subject Matter Experts

)

= Define case types and
activities

= Define business objects

= Author simple
responsive Uls

= Consume pre-built
process components

Knowledge Workers

= Responsible for “job” (case,
task, or combo)
= Triggers ad-hoc activities in
response to business conditions
Monitor process performance
Collaborates with others
Leverages content in context
Routine work is automated as
much as possible

Avalilable anytime, anyplace, anywhere

10

[ Y O\ N N N

o
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Reinventing operations begins with collaborative process discovery

= Business-user friendly SaaS offering for
modeling processes and decisions

= Cloud-based application and repository enable
teams to collaborate in real-time and stay in
synch on current process and decision models

= Easy, low cost entry point ($50/month); free
30-day trial

What's new

= Private cloud option delivers single-tenant hosting on
dedicated hardware and software

BlueworksLive

Process made simple

Visit BlueworksLive.com
to learn more

© 2014 I1BM Corporation
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Typical approach| disconnected process discovery
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supports broad participation as the main focus at
the start of each BPM project
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Reinventing operations requires speed and agility, exactly what
you get with IBM BPM on cloud

Business & IT Authors

End Users

4E~ -
: EJ BPM on
_ — Cloud Admin -

Process
and

Integration
Designer

IBM
Business
Process

Manager

Email notifications

Process PiIOUPrOd uction
i environment

' e
&) T
i environment

_ Repository
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= Pilot Project
» Proving the business value
= Try out a newer version of BPM

= Development

» Organization can manage production solution on-premise, but needs to get started
fast to meet go live date

» |nstead of an on-premise solution
» Organizations with small IT department
= Urgency for implementation
» Prefer opex to capex

© 2014 I1BM Corporation
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Mobile is a game-changer for achieving customer centricity

!\Je_qu enacaement ot
buswess moments

S (G e

SMS Mobile apps Mobile email

New Context New Process
Digitization
‘& -
20 % N
b 4 <> -
O 4 X = @
_ Location Speed & Sentiment : | 7 )
direction : Photos Business Identity
: I Content
u = i h‘-x\
> ™.,
f"'/ﬁd '“
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Focus of Smarter Process Industry Accelerators for Mobile

Banking

Account Opening
Trade Processes
Banking Operations
Wealth Management

Underwriting Process
Claims Sobrogation
Re-insurance

Mobile Claims

Agent & Policyholder Care

Telecom

Order Management
Mobile Device Diagnostics
Subscriber Care
Connected Car

https://w3-connections.ibm.com/wikis/home?lang=en-

us#!/wiki/W55eec9ffbec5 4121 9dcf 0d13c3c43c57/page/Smart

er%20Process%20Assets%20by%20Industry

\ » Discharge Readiness
N s”s " Providers Relationships
*= Claims and Quote to Card
0« = Coordinated Care
=  Public Health
Healthcare
M1/ _ = Elgibilty & Permits
AN, = On-boarding
o fim = Citizens
‘!Eﬁ » Employees
Government
\\ ' /, = Health & Wellness Portal
II‘II = |n Store Associate
'|‘_ I =  Performance Dashboard
"y = Mobile Storefront
Retail

Combined MobileFirst StarterApp &

Smarter Process Accelerator

© 2014 I1BM Corporation



... Leverage Partner Ecosystem for Value-Add Software &
Services for IBM BPM

B Mobile Portal for (EBRAZOSFORTAL
IBM BPM v8.5.5

e iOS and Android devices

 Process and Task access
anytime, anywhere

e Fast, responsive design for
smartphones, tablets

e Innovative “filter-dial” for —
task filtering and '
navigation

* Free to use!

e Optional support available
from BP-3

For more info:

© 2014 I1BM Corporation
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The Ottawa hospital provides patient-centric care

Challenges

= Needed patient focused processes to improve
quality of care with better visibility

= Need to improve key metrics: Patient wait times,
Discharge rates, Instances of relapse

Solution

= BPM, Business Rules and Mobile to create a
‘Circle of Care’ visual interface improves
communication and collaboration within the care
team.

Benefits

= |nstant: Faster consults and treatment through
the electronic closed-loop consult service

= Seamless: Improvements in patient flow through
the hospital and easy access to patient information

“What we are doing is putting process orchestration and = Insightful: Benchmarking process execution to
process models in place, so that you can literally see the use historic and real-time data to make better
characteristics of the hospital system... and you can then patient care decisions

influence that.”

~ Dale Potter, Senior VP and CIO, The Ottawa Hospital.

© 2014 I1BM Corporation
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BES - improves customer’s experience by eliminating shadow processes

Challenges

= Achieve strategic goal to improve customer
satisfaction; open a new bank account in less
than 20 minutes

= Roll out new processes faster, so new products
can be offered sooner

Solution

= BPM solution to quickly deploy new products and
services

= Business users directly manage the changes to
the business process

Benefits

= Simple: Business users built and deployed 200
processes to production within 18 months

Business users built/deployed 200 processes in 18 months = Pervasive: Created 80,000 process instances
“If you seek to be customer centric, customer focused, it with over 3,000 users per day over a 12 month
requires you to be a very efficient provider, a very flexible period
provider, on the back end in terms of your processes.”

= Applied KPI metrics to improve SLAS across

processes

~ Miguel Rio-Tinto, CIO, Banco Espirito Santo

© 2014 I1BM Corporation
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A leading European energy company makes metering smarter

Speeds up deployment of new processes Challenges

= Need a scalable, flexible and robust smart metering
platform to meet changing market needs

= Constantly changing regulatory environment with
policy changes every 6 months

Solution

= Smart metering platform built on IBM BPM, IBM
ODM, DataPower, WESB and Tivoli Asset
Management

‘;: 77 = GBS and ISSW developed solution, managed and

r i
g
3

it hosted by GTS

Benefits

i = |Instant: Customers can directly access energy
usage data and make choices on energy providers

| = Seamless: Interconnects individual consumers
with a variety of energy retailers and grid operators

= Insightful: Enables the grid to only produce the
required energy and put surplus solar energy back
into the system for use by other companies

© 2014 I1BM Corporation



More examples of client centricity and success with Smarter Process

Client situation

HIPRA (Pharmaceuticals)
Needed end-to-end visibility to better manage .
contaminated vaccines in the pharmaceutical
supply chain

Duke University

Challenged by inefficiency, lack of visibility,
and duplication of work, all adversely
affecting customer service levels for their
academic community

Odyssey Logistics
Next-generation supply chain management

(SCM) platform to help provide end-to-end
transportation solutions and reduce costs for
customers.

IBM Internal Use Only

Solution

Multiple systems of record needed to be
coordinated with an over-arching business
process
Other patterns
» Parts of the business process were very well
defined by regulatory requirements
*  Mobile workforce directs next step of the
business process based on work context

Replaced a “shadow process” of emails and
spreadsheets
Very small IT staff wanted a fully-managed, cloud-
based offering with monthly pricing
Had three goals for the project
* highly automated workflow for licensing data
* ateam-based approach for doing work
* on-demand visibility into process performance
metrics

Pre-constructed best practices based on sets of
common activities that can be quickly customized

for local needs

The system guides the user to the next task to
complete the work rather than the user having to guess
the correct choice

Processes change frequently based on different
customer needs — but efficiency and performance are
also critical

© 2014 I1BM Corporation



Vallalati mobil platform esettanulm  anyok

Toth Balint
WebSphere brand sales manager, IBM
balint.toth@hu.ibm.com
Banki Zsolt
Uzletfejlesztési vezets, UniOffice
banki zsolt@unioffice.hu
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A mobil app-ok 80%-at egyszer hasznaljak, majd torlik!

A nyilvanos app store alkalmazasainak >50%-a ‘halott’!

DEAD APPLICATIONS

% of applications with less than 10 notes et reviews
and without updates

Today,

more than 700 000 apphcations
(so more than 50% of total
applications available)

can be considered as dead.

Source: Stardust, sept. 2013 © 2014 IBM Corporation
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£ Search
Aer Lingus
Aer Lingus >
Facebook
Be the first of your friends to li
this.

App Store Ratings

[ Current Version

‘December put was given dates 1n Uct
incidentally, was spelled Octobeer

5. Poor poor app

* i 44 v by Lucky Gooner — 6 O
This app doesn't just need tweaking k
taken away and built from scratch. Yol
going on the mobile web page and do
need to do there. For a relatively big a
comparison to other airlines apps, this

6. No Passbook support is
* v+ by lan Mac 64 — 30 Ocf
You should be able to store the boardi
passbook instead of having to open s
Having to open my emails, find the linl
safari makes it more inconvenient tha
traditional way! EasyJet, British Airway

7. Rubbish app
* 7ove 407 by Deraig484 — 3 Nov 2
Years behind other airline apps.

* -+ 196 Ratings for All Ver
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*
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ecooo yodafone UK & 14:34 ¥ 63% I »
£ Aer Lingus =
Version 2.71 Updated 30 Nov 2013
Bug Fixes.
Version 2.60 Updated 15 Nov 2013

The IOS 7 friendly version;

- Superior Performance - lighter, faster, more efficient
- Improved Design - |0S 7 friendly

- Advanced Features - improved & simplified flight
selection process... more

Version 2.51 Updated 17 Sep 2013
Bug Fixes
Version 2.5 Updated 22 Aug 2013

> Business Fares now available on the App (standard
business class fares only).
> Bug fixes.

More great improvements on the way... more

Version 2.4

> Improvements to;
- Select Dates Calendar

- View My Booking

=~ Minnar Rua fives
Charts Near Me

Updated 28 May 2013

= m

Updates

Q

Search

PAY

Featured

Top



eeee0 SFR T 11:56 eeeeC SFR = 11:56 11:57 96% [ 4

eeec0O SFR =
£ Search

£ Search |: £ Back

Version 1.4.0 Updated 18 Dec 2013

This update includes the ability to:
+ View and cancel Direct Debits and Regular

Nationwi 3. Superb banking app

Banking *#*** by Stevohhh — 18 Dec 201: Payments _ o
Nationwid: Cleverly thought out and intuitive user inte + Set up future dated bill payments to existing payees
a breeze to use, so 5 stars all the way.
Version 1.3.1 Updated 3 Oct 2013
%k ok e (47

|

Facebook

4. Mobile bankin
* % %% by DaintyChick — 18 Dec 2!

Don't know what I'd do without the Nation
Absolutely brilliant!!!

This update includes:

* A bug fix for iPads running iOS7.

Version 1.3.0 Updated 25 Jun 2013

Be the first of your friends 5. Brilliant Based on customer feedback, we’ve made
this. . improvements to the Nationwide Mobile Banking app
i SRR G L R L R to help you manage your money on the move.
Brilliant app. Provides a very convenient w
App Store Ratlngs checking balances, making payments and  \yjith this update you can now:... more

money. What more can you want on-the-g

[ Current Version -

Surprised Nationwide hasn't advertised thi

**#x 1,167 Ratings for A

Version 1.2.0 Updated 5 Dec 2012
Minor bug fixes to improve customer experience.

6. Brilliant!
b 6 6 6 & ¢ -
PEAE * %% %% by Rowley69 — 18 Dec 201 Version 1.1.0 Updated 12 Nov 2012
KAk — This is just what | needed. Well done natioi Now supports iPhone 5.
XX — ‘app!! .
Featured Top Charts Near Me Featured Top Charts Near Me Search Featured Top Charts Near Me Search Updates



Bank of Montreal

= >12 millio ugyfel

= 8. legnagyobb bank in Eszak-Amerikaban
eszkbzallomany szerint

» Elsé mobil app: 2011-ben
— gyenge ertékelés

» ~1 milli6 mobil banking felhasznalo

» 2013 vegeén: uj mobil app fejlesztés IBM
mobil alkalmazas platformon

© 2014 I1BM Corporation



Uj funkciok a kompetitiv hatrany ledolgozasara

L 11:43 AM

L
—

Frangais | = SEND e-Transfer PAYMENT CONFIRMATION

BMO M  Bank of Montreal

I R Roy )
jrreydemail.com

0 Success! Your future dated
Easd payment has been saved

Chequing 3
£3,994,00 (a0

§123.87 is scheduled to be gaid to ROGERS CABLE
TV (578912345556) lrom Chequing on Jan 10,
2015.

Card nickname {optional)

$100.00

"_ll‘!-. Remember my card rp— ;

johniemail com
Relerenos #: 410

Fay Another Bill View Accaunts

Mext

COMNTALCT U5

Multi-card P2P Post-dated
Support Payments Bill Payments

© 2014 I1BM Corporation



Innovacio az ugyféléeim eny ndvelése érdekében

() Book an Appointment

4 Eack BMOD u g

Book an appointment

& select 3 location

1] Select a discussion topic
E Select a Date and Time

_1 Provide contact

Appointment
Booking

Francais

>

>

11:43 AM

TRAVEL NOTIFICATION ACCOUNT

Sait i

MasterCard
5524-5912-3454-7890

$932.77

Select Credit Card(s):

MasterCard Transactions Account Details

5524-8912-3455-7390
Current Statement Activities

Enter details of your Travel Plans:

(urrent Balance 593277

Minois, United States
From: Feb 15, 2014 1o Feb 28, 2014 Last Payment N
Fhone: 4165551234

Last Payment Date Sep 18, 2014

Details Add destination details )
Craschit Limit 55,000.00
vilalle Credil 54,047,213

Statement &
Account
Details

Travel
Notifications

© 2014 I1BM Corporation



Fokuszban a kdnny G kezelhet 8ség

sull Bell 2228 PM

1=
ACCOUNT SUMMARY —

TIPS & HINTS
Account Surmimany
! # Bank Accounts # BMo &
Transfers
. Primary Chequing Account Lorem Ipsum
Dolor Situe Consecturer
BAEG 4440-EED
Ralane 540,000,000.00
Avallabbe lunds 547,000,008

PAYMENTS Meet with B0

Make a-Payment
ake o-Paymen Book an appointment

Bayiment History

Find ari appakitment
« Prembum Rate
Savings Adcount

Manage Payee List

5400,000.00
aTRANSFER

Book an Appointment

Meed to speak to someone about
your banking needs? Quickly book
your appointment at the date,
time, and branch location that
wolks best for you.

B Lo ~ Other wo $10,000.00

View, Candcel Reminder

& Credit Cards

Manage Reclpients

MORE =~ MasterCard

Side Sliding Gesture Tips & Hints
Menu Optimized
Navigation

© 2014 I1BM Corporation



Eredm ények 1 honappal az éles indulas utan

Improved Experience Customer and Productivity
Impacts
Old App Score New App Score
e * Apple AppStore: Named Best
. 9 9 New App and Featured App
2.0 4.5 in Finance Section
 Blackberry World: Named Top
9 e Free App and Top Banking App
3.8% 41 « 2000+ Branch Appointments
booked
e 9 e * 5000+ Travel Notifications sent
2.0 4.5

© 2014 I1BM Corporation
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Kihivasok...

Mobil app: NEM csak a
felhnasznaloi felllet...

70%

Cross-Platform Analitika
Fejlesztés
és Tesztelés

Adat Biztonsag
szinkronizacié

App Integracio
Management Push g
Notifications
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IBM Worklight : Mobile Application Platform

Manage

Run

Deploy

Apsication Ernarrae|

I‘ ot aat.
ot e e
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Az 0j IBM Worklight Platform

Integralt mobil alkalmazas fejlesztés és lizemeltetés

e @ Quality Assurance
Application \/ 4
Scanning Application Scanning

Detect code security vulnerabilities
at the time of development

Quality Assurance
Server Runtime Collect beta test feedback, crashes
and analyze user sentiment

Studio = c | Foundation
TR onsoie Development, Runtime, Operations
Console & Private Store
E Application Center

m

Development Continuous Delivery

© 2014 I1BM Corporation



IBM MobileFirst
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Banking Insurance Retail Transport Telecom Government Healthcare

l IIII

Automotive

IBM & Partner Applications

App Development & Data Platform

= \

Management Security Analytics

S92IAI8S uoneibau| % uawdojenaq

~N

~

Devices 'S Network 'S Servers

7

v

Cloud & Managed Services

v
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Mobil alkalmazas platform — mikortol elkertlhetetlen?

Koltség, komplexitas, kockazat

A

1 App
1 Device
1 Backend

>

X
N
((\

1%°

3 AppsS or
3 Device or
3 Backends

A

Gartner szerint:\

X Apps

X Devices
X Backends

I3IX3I X3
\ 4

Platform

vagy ad- g
hOC?, o

Time
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Vezeté megoldas az IBM-tél

Figure 1. Magic Quadrant for Mobile Application Development Platforms

MicroStrategy 0
salesforce.com ‘ . Antenna
. Appcelerator
@ Apple
DSI .
Usablenet @ Gooale
g . . . Sencha
Dojo
@ Xamarin
@ Netbiscuits
E . Microsoft
[
% BlackBerry @) ®) @ Verivo Software
o .
; ClickSoftware Motorola Solutions
=
-
2
COMPLETENESS OF VISION ~ ——>» As of August 2013

Source: Gartner (August 2013)
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China Railway - jegyrendszer: nagyléptek G skalazas

@ b E L IE B SRS PR | ziEEs

.......

xR, MAES A

PR RlkD, MBS iAtREE!

@ iPhone T&; I Android &

: AR SEE TR
A S 12306 FNE il

16 millio letoltés 2 honap alatt

1,6 millio egyedi napi felhasznalo

0,3 millio egyidej G felhasznalo (csucs)

100 millio napi ‘hit’ © 2014 IBM Corporation



Nearest Service Center

UAE Belligyminiszterium — mobil app RE Ry

Filter by service °

Saaryar

lsland - ;
(=] o gyl

~uba sl
0 4

MU DHABI

.<'|J-.: 44

UNITED ARAB EMIRATES
MINISTRY OF INTERIOR

UNITED ARAB EMIRATES
MINISTRY OF INTERIOR

EXPO 2020 | si3, | 2020 guuS =

S, T ARk prmaT S A g

Dubai, the world's choice‘___

% Congratulations UAE

200

TR

Vehicles Registration

) Q * A 999
P £ Replace ~_ Replace Home  Centers  Favories  Alerts  Emergency
= Damaged = Lost
Traffic Civil Defence Police Residency o i 11:39
Traffic Fines Payment
i i scee _ = 5

Guidelines | ' | 3 = Traffic = License @ Plate Your card details

ngare Road S'urprises‘: Beware Roaq ngprlses Is a R Number Number = Number Please enter your details to continue

simple expression but it has a great significance. The Total Amount 600 AED

driver as the active and dynamic element of the traffic

Latest News Sas ®@ Drivers Try Date

Ce |;™ Mon, 02 Sep 2013
.}m Abu Dhabi Civil Defense Extinguishes Fire at _

Expiry Date Month ~ = Year v

Musaffah Power Plant I® Reserved Plates

~p All news
Follow us at n u
Follow us at n u

A Q * | 999 L. Q * i 999

£ Q * i 999

Home Centers Favorites Alerts Emergency Home Centers Favorites Alerts Emergency home  Cemers  Faertes  Aers  Emesency poration



Smarter Insurance — mobil BPM akcidban

(video demo)
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Vallalati mobil platform — hazai példa

) Banki Zsolt
Uzletfejlesztési vezetd, UniOffice
banki zsolt@unioffice.hu

Tt ¥,
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/ TelOffice

l “
AL

Ugykovetés Csoportnaptar Partner

i!" e o © 2014 1BM Corporation
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< Vissza ﬂ Partner
(@ )
Keresés akarhol a névben ( ) Ki

Partnerek a kozelben ... J

Kérem hasznalja a keresést!

Pariner
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( Vissza ﬂ Partner

(?CLBarna

ﬁ\.

Keresés akarhol a névben

Barnané Juhasz Magdolna - Xe... ?
Barath Barna - IDV Central Eur... ?
Binder Barna - Precizios Mérés... 7
Bodi Barnabasné - RABA Jarm... »
Eperjesi Barnabas - Kossuth La... >
Jakab Barnabas ?
Kovacs Barna - TIGAZ Rt. - Szd... »

Kalman Barnabas >

<)

Pariner
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( Vissza Partner adatok

Palinkas Barna

Polar Mobil Kit.

céges

+36 (1) 451 4850

Ccéges

+36 (1) 451 4840

Cég

1097 Budapest Konyves Kalman krt. 5.

& &
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, "3
<V|ssza Csoportnaptar

J 2014.06.11 LJ

Ma

13:00-13:01 o Privat bejegyzés

Szonda Laszlo

15:00-16:00 ¢ Kisz Itp.

Jonas Gabor

15:00-16:00 ® megbeszélés -
lehetoségek és egyebek
Banki Zsolt

16:00-17:30 o Privat bejegyzés

Bene Laszlo

18:00-19:00 # Call Vajjon

Jonas Gabor

18:00-19:30 ¢ Szerdai foci

Szonda Laszlo

W)

Esemény szel Név szerint
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{ Vissza l Ugykévetés
Jovahagyanddk

Arajanlat fejleszt6i oktatasra
Ugy: _Mobil demo

Arajanlat Lotus Notes felhasznaléi
képzésre )
Ugy: _Mobil demo

Arajanlat migraciéra N
Ugy: _Mobil demo

Arajanlat rendszer {izemeltetésre N
Ugy: _Mobil demo

Arajanlat verzio frissitésre N
Ugy: _Mobil demo

Egyiittmiikodési szerzodés
felmondasa )

J @

Jovahagyas Szlgnélas Figyelmembe
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(Vissza  Ugykévetés dok.

E Arajanlat fejleszt6i oktatasra
. UOP-0072-008/2014

Kiado: Pfeiffer Ferenc
Felelds: Pfeiffer Ferenc
Hatarido:

Jovahagyas:

Események: 2db ?

Jovahagyom Elutasitom
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VIR

Fﬁ Jelenség felvitele (térkép) >

g Aktualis fokozatok )

.| Agazati cimtar »

Tavmondatok )

B Ugyeletek )

<
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Koordinatak: 47.41324208215569 /
18.82833849640454
Jelenség:

[Jelenség_: n

Leiras:

Jelenség rogzitése

, | Grel, 1_'erkep | Mihold |

~anied

< > Done

Zliranyu repedes

éﬁrkolat sertlt
Szivargas
Csurgas

Stllyedés

Billenés

Y_-" = ' e = '.'f:.—, S
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18.82833849640454
Jelenség:

elenseg renzitese

Koordinatak: 47.41324208215569 /

[Csurgés

Leiras:

|

1 1eva

Gret Térkép | Mihold |

\S
2 2
o -~
\% %, ?é
\'% i ’
\ %
h? Soskut
Bajc% \ (" posta |

esfi'in‘ﬂﬂ’
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..Vissza VIR Ugy&lEtESEk

- (20140021 | 4]

ADUVIZIG »
ATIVIZIG »
DEDUVIZIG )
EDUVIZIG >
EVIZIG >
FETIVIZIG »
KDTVIZIG »
KDWVIZIG »
KOTIVIZIG )
KOVIZIG >
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VIZIG: ADUVIZIG

2014.04.21 hétf6
Kilss Péter

+36 20 111 1111
2014.04.22 kedd
Nagy Janos

+36 70 222 2222
2014.04.23 szerda
Kovacs Géza
+36 30 333 3333
2014.04.24 cstortok
Kelemen Istvan
+36 20 444 4444

2014.04.25 péntek
Kiss Péter

+36 70 555 5555
2014.04.26 szombat
Nagy Janos

+36 30 666 6666
2014.04.27 vasarnap

Knvare (RA7a

< & & & & &
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Mire j0 a ,Data Grid”?

Klis Csaba
IBM WebSphere Client Technical Professional

2014 junius 12.

4 7,
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Megallithatatlanul ndvekedé IT tranzakcioszam
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A valaszidé kritikussaga

Page views Conversions Customer Satisfaction

C Ci C U VvV Tl AP Ci U . U U C AT VWU U U \_J C cLVU U, DU|C y AUCTUCCT D1UUY, NUVC JCT 08

2. Source: Internet World Stats, Usage and Population Statistics, www.internetworldstats.com/stats.htm, December 22, 2010
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A megnodvekedett tranzakcioszam hatasai

Edge Tier Application Tier Integration Tier Back-end Systems
Database Tier
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Gyorsitotarral optimalizalt architektura

Edge Tier Application Tier Integration Tier Back-end Systems
Database Tier
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Mi a Data Grid?

Elosztott, in-memory objektum cache

* Rugalmas, skalazhato
* Dinamikusan cache-e¢li, particionalja, replikalja az
alkalmazas adatait tobb szerveren

Hatalmas mennyiségd tranzakcio végrehajtasa

» Szolgaltatas mingség garancia: tranzakcios integritas,
magas rendelkezésre allas, tervezhets valaszidsk

Onjavitd képesség, skalazhatosag

e Automatikus hibattrés
» Tarolo kapacitas bévites / szdkités menet kdzben

Adat konzisztencia biztositasa

» Hattértarral
* Replikak kozt

64 © 2014 I1BM Corporation



Hagyomanyos cache makodése

Uj server, iires

. i cache-sel
- Kapacitas = 1 JVM mérete - '

» Nagy terhelés az

érvénytelenitési logikaban -
: i _ = K‘\__
* Hideginditas megterheli a

P

—~

Janey) uonepifeau
/\
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Data Grid skalazhatosag

 Logikailag egyetlen cache,
tobb particidban

» A cache kapacitasat a teljes
cluster mérete hatarozza meg
* M= Cache-ek meérete
* N=# JVM
* Teljes cache =M x N

* Nincs jelentds
érvénytelenitési terhelés
* Linearisan skalazhato

« Kisebb terhelés
hidegindulaskor

*illustrative topology

© 2014 I1BM Corporation



Data Grid teljesitmeny

 Alacsony kesleltetes
» Near cache lehetésége

« Optimalizalt transzport
protokoll és adatformatum
(eXtreme 10 transport,
eXtreme Data Format)

© 2014 I1BM Corporation



Data Grid replikacio es rendelkezésreallas

= Egyszerd konfig (szinkron /
aszinkron) HA-ra

= Szabalyozhato a replika

elhelyezése (lokalis / tavoli) _

= Telephelyek kozt
= Fizikai szerver szintjén
= Szerverszobak kozt

s Multi-master Replication (MMR)
= Tree / Hub and spoke / Circular
s Adat konzisztencia + Magas
rendelkezésreallas

© 2014 I1BM Corporation



Side Cache

e-Commerce example: http://www.ibm.com/developerworks/websphere/techjournal/1008_genkin/1008_genkin.html

© 2014 I1BM Corporation



Inline Cache

Performance benefits: http://www.ibm.com/developerworks/websphere/library/techarticles/0906_vuong/0906_vuong.html

© 2014 I1BM Corporation



Adatfeldolgozas a Gridben

e Az Uzleti logika az adaton hajtodik végre — (Co-location)

e Nagyon hatékony tranzakcios teljesitmény!

g ObjectGrid ™\

ﬁ Application agents 5
ﬁ Application agents E

ﬁ Application agents l

S J

© 2014 I1BM Corporation



WebSphere eXtreme Scale API-k

= JAVA: ObjectMap / EntityManager API
= .Net

= REST

= Object Query
= Loader

Cluster

WebSphere eXtreme Scale
Fault-Tolerant,
Elastic Data Grid

Cluster

Cluster

© 2014 I1BM Corporation



Integracios scenariok

» Adatbazis / Backend objektum cache
= Alkalmazas / Portal szerverek
= Dynacache lecserélése
= HTTP Session
= |Integracios szoftver
« DataPower XG45, X152, XB60
 WebSphere Message Broker
* IBM Business Process Manager
» |BM Operation Decision Management
= Mobil

73 Go to 'View > Header and Footer' to change this footer text to the event title
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HTTP Session replikacio

74

A grid hasznalhato HTTP Session
objektumok tarolasara is

Izolacié — alkalmazas kiszolgal6
tehermentesitése

Lineéris skalazhatésag

Automatikus replikacio / akar
telephelyek kdzott is

Datacenter 2 Eg|astic Cache

Multi-master replication

Datacenter 1

© 2014 I1BM Corporation



WebSphere Message Broker v8.0 - Global Cache

Clients

WebSphere

] Broker . 4
522298 IO Raquests Global cache scenario 1 : Allapot
Request | —* Ol , , s .7
,EE T *—% R tarolasa, pl. Request/Reply korrelacios
D = v 7 yd V4 yd V4
Fasponse | azonositok tarolaséara

e WD

Responses - not necessarily
WebSphere sent back through the same

Message Broker broker as the request

Global cache scenario 2 : Backend . WebSphere D13 tached /\
e Zas Cllants Message Broker
gyorsitotar

Back-end system

75 Go to 'View > Header and Footer' to change this footer text to the event title © 2014 1BM Corporation




Referencia: Worldwide Fantasy Sports Web Site

Entertainment 10x
5 Milliard csokkentett

- valaszidé
kérés naponta

Cameniir WEHE Clhe eoivion

BALANY LA

Pk PR [T T
— e ——
Tia 1a% eh 4 ] i

Fantasy Sports Web Infrastructure
- Elétte: 60ms DB valaszidé

- Utana: WebSphere eXtreme Scale
megoldassal 6ms-ra csokkent

- 450k konkurrens felhasznalo
- 80k kérés / sec-rél 1M-ra

— 6 hét alatt koncepiobdl éles makoddeés

76 Scalable Caching in an Enterprise Environment with IBM WebSphere eXtreme Scale - Overview
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SOA a gyakorlatban

Gulyas Gergely
WebSphere Services Specialist
Certified SOA Associate
gergely.gulyas@hu.ibm.com

y
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SOA: Szolgaltatas Orientalt Architektura

“Olyan architektlra, amiben az alkalmazasok lazan kapcsolt és jol
definialt szolgaltatasokon keresztll integraltak”

v'Lazan kapcsolt > A szolgaltatas implementaci6ja el van rejtve a szolgaltatast hivo
fél elsl

v Jol definialt > Egységes, szabvanyos szolgaltatasdefinico, amely teljesen
technoldgiafiiggetlen (Java, .NET, ..)

SOA elényeil:

» Ujrahasznosithaté szolgaltatasok meglévé és Uj alkalmazéasok
felhasznalasaval

= Uzleti folyamatok és IT technoldgiék izolalasa

» Integracios folyamatok felgyorsitasa

= Nyilt szabvanyokra alapuld integracio

© 2014 1BM Cagporation



A SOA mindenki szaméara mast jelent

t0 szolgaltatasok
k szamara

an csatolt,

anyok alkalmazasan

Definialt szolgaltatas minéség, mely egyiitt tartalmazza az
Uzleti és a technikai metrikakat. Fellugyelet

© 2014 I1BM Corporation



ESB (Enterprise Service Bus)
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= Az ESB nem ,csodafegyver”
= Nem célja, hogy tamogasson minden nativ protokollt és egyedi megoldast
= JO megkozelités: Gyors fejlesztési modell
—Modellezhets
—Elére gyartott / kiterjesztheté komponensek
—Szabvanyok minél szélesebb kdrd tamogatasa
= Nem workflow !

—Az integracios folyamatok jellemzéen allapotmentesek €s gyors
lefutasuak

March 2, 2011 IBM Confidential © 2014 1BM Corporation



ESB referencia architektura

Konnektor
Fajl
szolgaltatas
Kliens #1 \ -
o Web Services
M| szolgéltatas
Gateway > Web Services reteg
Kliens #2 A \
9 Adatbazis
—© Service orchestration
O_
—O
Legacy back-
y end
Kozos szolgaltatasok: (pl.: naplézas, tranzakcios audit, security, service
registry)
| |
ESB
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» SOA metodoldgia hianya

» HiAnyoznak a szolgaltatas tervezesi hianyelvek
= Nem definialtak a felelésségi korok

» Projektorientalt és/vagy ad-hoc megkdzelités

» KOvetkezmeénye:
—Redundans szolgaltatasok
—Atlathatatlan fiiggéségek és infrastruktira
—Ad-hoc megoldasok
» Megoldas
—SOA Governance

—Tamogato termékek — pl. szolgaltatastar alkalmazasa (6nmagaban

nem megoldas !)

© 2014 I1BM Corporation
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» Adatmodell, elnevezési konvenciok

» Protokollok, hivasi metdédusok keverese
—Szinkron / aszinkron modell keveredeés
—Eltérs hibamodell

» Szabvanyos vs. nem szabvanyos megoldas
—Meddig lesz tamogatott a nativ protokoll?
—Vendor-lock

» Biztonsagi problémak
—Biztonsag vs. teljesitmeény

© 2014 I1BM Corporation
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= Mobil kiterjesztés
—SOAP vagy REST
—HTTP vagy MQTT
—Biztonsagi kérdések

» Valtozo makodési modell -> felhs
—Meég nagyobb rugalmassag sziikséges
—Terheléselosztas, skalazhatdsag (pl. cache)
—Biztonsagi kérdések

March 2, 2011 IBM Confidential © 2014 1BM Corporation



Integration .
Gateway IBM Integration Bus

- eRPiEIS/ICRM J B

iiié‘;.ms, Msua 'E‘:I-mii.cmicsng.:__{f A

{ Microsoft

e Datapower
« Atjaro szerep (routing, security, naplozas)
* Nagy teljesitmeny

* |IBM Integration Bus (korabban WebSphere Message Broker)
,Klasszikus ESB”
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Vallalati alkalmazaskornyezet Uj alapokon

Toth Balint
WebSphere brand sales manager
balint.toth@hu.ibm.com

27T
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IT koltségvetések felhasznalasa 1996 — 2013

$217 8B
S1758B

$1308B 12%

$100 B 16%
119

S247 B est.

11%

46% 51% 66% 69%
1996 2001 2006 2011 2013
L] Uj beruhdzds " | Energia és h(ités

Source: IDC, 2012 J Mlkodtetés
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PureApplication System: Uj megkdzelités az Informatikaban

Példa: BPM kdrnyezet

* Hetek - HOnapok munkaja

(\_@ REd b00ks® -
developerWorks.

Patterns:

» < 90 percnél rovidebb ideig tart
egy komplex, tobbszori telepitésre
el6készitett, magas rendelkezésre
allasu, csokkentett karbantartasu
kornyezet létrehozasa

-Manaqement:

« Egyszerlibb menedzsment és
karbantartas, az alkalmazasok
szamara beépitett
terheléseloszlassal kiegészitve

© 2014 I1BM Corporation
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Purellex

ex System

— S

Infrastructure

Delivering Cloud
Infrastructure Services

I
PureApplication

Application Platform

Delivering Cloud
Application Platform
Services

PureData

Data Platform

Delivering Big Data &
Analytics Platform
Services
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Other ISV Apps

Other IBM SW

App Server
Database
Mgmt / Provisioning

Monitoring

Virtualization

Operating Sys.

Servers

Storage

Networking

Separately
Purchased

\ Pre-integrated & Pre-entitled with unified support )

Alkalmazas platform

Pattern-ek segitségevel
konfiguralt

Kozpontilag menedzselt
Dinamikusan skalazhato
Magas rendelkezésre
allasu

Integralt (HW, SW)
Egyetlen IBM cikkszam
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Pattern: adott rendszerre az IBM és Figgetlen alkalmaz  as fejleszt 6k
tapasztalatai alapjan készitett konfiguracios leir6 a  llom any, tesztelt,
optimalizalt és telepitésre el 6készitett form aban.

* Egy alkalmazas el6re definialt architekturaja s

» Monitoring
Lifecycle
# Management

» Az alkalmazas minden komponensére vonatkozéan /4
(pl. hardver, adatbazis, webszerver, stb) /

» Operacios rendszerre installalva
| WR|

Komponensek kozt integralva s

erver

El6re konfiguralva és hangolva

El6re konfiguralt rendszer feltigyelet

!ﬁpn

Deia b

El6re konfiguralt biztonsag

Eletit menedzsment (licensz gazdalkodas)

» Telepitésre el6készitett, tobbszor is felhasznalhato konfiguréciés%ﬁé_hény

© 2014 I1BM Corporation



Osszetett alkalmazasi kornyezetek létrehozasa

PureApplication

HA Proxy

If Monitorin, Deployer 1
H Agent g A‘;;eX? ]
i ]
| 5
! HA !
Proxy

—— e ,

Monitoring § Deployer
a
WAR ]
File i
|
|

Application
Server

Caching
Server

Deploy Spplicaton

Monitori Depl ] Monitori Depl i
! i Schema i
Caching § , ,

> Monitoring
Lifecycle
Management
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IBM PureApplication System - [ Pattern Type: Web Application Pattern Type 2.0]

Diagram List View Saource

(] save | B saveas |
Assets
w Application Components

Additional archive fila

[“1.  Enterprise Application

% Existing Web Service Provider Endpoint
E’&“‘EI Policy set

Web Application

= Database Components

J Data Studio web console

3 Database

¥ Existing Database
8,
5 Existing Database
37, ° 1
T Existing Database
& 9 A&

@; Existing IMS Database

+ Messaging Components
_ . Existing Messaging Service

p—

= Queue
[

== Topic
2

+ 056G Components
"  Existing 0SGI Bundle Repository

05Gi Application

g |

 Transaction Processing Components
+#It  Existing CICS Transaction Gateway /3

IS Existing IMS TM

£ Layout | < Undo | % Redo

| 4 Add policy for application

E &% | X

[ ; :
= Enterprise Application

i .
| -y i i
! &, Scaling Policy

I B2 Routing Policy

 TradeLite

LS

Virtual Application Builder - [ DayTrader]*

Database

TradeDB

[“1; Enterprise Application
Ik

* Name:
TradeLite

“ EAR file:

artifactsftradelite.ear  |(Edit| [Delete|
Total transaction Iifetime timeout
(seconds):

Async response timeout (seconds):
Client inactivity timeout (seconds):
Maximum transaction timeout (seconds):

Interim fixes URL:

[ Select = |
Ignore inapplicable ifix updates: | |
Maximum Session Count:

'_3: Scaling Policy

Enable session caching: [/
Maximum Session Cache Grid Size:
UNCAFPED

+ Scaling Type

| Response Time Based| [ ]

".icalling in and out when Web resporis-e
time is out of threshold range(ms):
0 10000

Range: 1000 - 5000
* Instance number range of scaling
infout:
A s
=iz
Range:1 - 10
* Minimum time (s5econds) to trigger add
or remove:



Diagram List View Sgurce

IBM PureApplication System - | Pattern Type: Web Application Pattern Type 2.0 |

Llsave | & savess | Bhtayowr | < Undo | & Redo

Assets

+ Application Components

Additional archive file

Enterprise Application
Bl

& Existing Web Service Fravider Endpaint

Policy set

Web Application

« Database Components

} Data Studic web consple

Database
Existing Database
Existing Database

Existing Database

2]

;@? Existing IM5 Clatabase

« Messaging Companents

Existing Messaging Service

= Queue
= Togis
& P

w (806G Components
j;,?" Existing O5Gi Bundle Repository
f‘f@ DEGH Application

» Transacton Processing Components

+i!  Existing CICS Transaction Gateway /3y

PR Existing IMS T

E

Add policy for application |

Via Applicaion pullder - Daylraoer |

* Scaling Type
Response Time Based

Scaling infout when Web response time is
out of threshold range(ms):
0 10000

Range: 1000 - 5000

Instance number range of scaling infout: *
Range: 1 - 10

Minimum time (sec) to trigger
add/remove: *

120

| Enterprise Application -
Lo >

" Name:
Tradelie

" EAR file:

attifacts/radelite ear  [Edit Delete|
Total transaction lifetime timeout
[seconds):

Async response timeout (seconds):
Client inactivity timeout [seconds}:
Maximum transaction timeout (seconds):

Iinterim fixes URL:

Ignore inapplicable ifix updates: |
Maximum Session Count:

" Bealing Policy -

Enable session caching:
Maximum Session Cache Grid Size:

UNCAPPED
- Bealing Type

\Response Time Based] | - |

Sealing Inand out when Web responze
time is out of threshold range{ms]):

Q ,,,,,,,,,,,, ‘?Q{:’c:)\‘:)
Fange: 1000 - 5000
“Instance number range of scaling
Infout:

§ ) 0

Range: 1 - 10
* Minimum time (seconds) to trigger add
or remaove:



Pattern

Beépitett

3 Tovabbi pattern-ek vasarolhatéak a PureApplication rendszerhez
Pattern-ek :

Application Pattern

Transac Lotus ESB " WS in :
DB Portal (IIB) SN Commerce [kl
WCM

Datamart
app

Msg Ext. IBM

System Patterns . R Connections
: app

WTX SOA SOA Sterlin nfoSphere
w/launch policy Gateway 9 ODM Info server

Flggetlen szoftverfejleszt 6k Pattern-jei (tébb 100)

PureSystems Centre

Extendi

www-01.ibm.com/software/brandcatalog/puresystems/centre/

© 2014 I1BM Corporation



Pattern”-ek

alkalmazasaval elérhet 6...

» Gyorsasag: gyors
alkalmazas implementacio,
magasabb megtérulési rata

» Hatékonysag: csokkentett
koltség, jobb erbforras
kihasznalas

» Egyszer (iség: kevesebb
tudas elegendé6 a
professzionalis
mikodtetéshez

e Kontroll: kevesebb hiba,
kisebb kockazat

IT Solution

Application Application
Application e i
Application

o
.0

‘ 20

Middleware \" Monitoting

Load balancing Datiba e

Storage %ﬁ Virtualization

Om“

Management

%

Compute Network
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PureApplication

9612 oOras éves raforditds 76%-kal csokkent - 2302 6réara - évente

Change Management

Image és firmware T
szabvanyositas, komponensek
kapcsolatanak atlathatdsaga,
kordinalt automatikus
rendszerkezelés

d Deployment Management
Automatikus és inteligens
telepités teljes
alkalmazas kornyezet
szamasra

Reduced
by 53%

Security Management———
Kdzpontositott apro

részletekre ligyel6 Incident/Capacity
hozzéaférés kontroll Management
Reduced
Reduced
by 25% Problémak

by 95%

automatikus és
elszigetelt kezelése
skalazas
segitségevel.

Asset Management

Felderités és license
menedzsement
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WebSphere Technical University
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Training - worldwide > Technical events & conferences » Calendar >

—2014
IBM WebSphere
Technical University 2014

28 — 31 October | Disseldorf, Germany

Overview Registration and Travel Agenda Solution Center

The IBM WebSphere Technical University is
an event delivering deep technical content
targeted at architects, developers, integrators
and administrators by offering lectures and
hands-on labs that focus on the best practices
and practical skills required to run today's
enterprise.

Attend the IBM WebSphere Technical
University and expand your knowledge of
BFM, Messaging, WebSphere Application
Servers and Infrastructure, including a focus
on SOA and Cloud Computing fundamentals

This event will be held at the Congress
Center Dusseldorf

Is this event right for you?

and advanced topics. You can also expect to Learn how this event can deepen your
o . skills on your organization's critical
gain insight into IBEM's software strategy and technologies.

learn about the latest development directions
for the products in the WebSphere software
platform

There will be sessions for the most experienced users, as well as introductory and getting-
started sessions for novice USsers.

Why attend -

Have questions?

& Conference Team +32 492 91 27 81

Registration will be open mid June

Early bird price: EU1835
¥ Ends July 10th, 2014

Full price: EU1995

http://mww-304.ibm.com/services/learning/ites.wss/zz/en?pageType=page&c=U948957Y84657D64
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